Diabetes Education Database Manual

For Microsoft( Access 2000

Why was the diabetes education database (dmeducation.mdb) developed?

The current database was developed to help manage a facility’s diabetes education program and make the data collection component simpler!

The database was designed based on the recommendations of the American Diabetes Association (ADA) for Recognition of Diabetes Education Programs.  (Program recognition meets the criteria for Medicare reimbursement.)  However, if your facility is not interested in obtaining recognition, but still has an education program or would like to start a program, we believe that you will find this database very useful.

What is Microsoft Access?

Microsoft Access is a relational database management system.  A database is a collection of related information (e.g. demographic data of patients enrolled in the diabetes education program, behavioral objectives for the patients enrolled in the diabetes education program).  A database management system is a system where the information is stored.  A relational database management system allows you to put information from different collections together - to relate them to each other - without actually putting it all in one place.

How do you launch Microsoft Access?

Launching Access is as easy as launching any other Windows application.  Just click on the Start menu on the toolbar (bottom of screen) and go to Programs.  Find Microsoft Access and click on it.  Access will open.  Select the circle next to Open an existing file.  Click OK.  Find the location of dmeducation.mdb and click on the file to highlight it.  Click Open.  (Alternatively, you can simply go to Windows Explorer and just click on the file.)

The dmeducation.mdb database will open.  A pink form will appear (Figure 1).  This main form is called a “switchboard form”.  The switchboard form will allow you to easily navigate within the database.  It has 7 buttons that allow you to open forms.  (Forms are used for entering, editing, and viewing data.)  There are 5 buttons for generating reports.  (Reports are used for presenting data.)  The 3 buttons at the bottom of the switchboard form are for closing Microsoft Access or opening the Database Window (Figure 2).  In addition, there is one button to print (blank) forms.  Clicking on this button will take you to another pink form that will allow you to select the specific form you are interested in printing.

*Note: Changing the screen resolution of your desktop area to 1024 by 768 pixels will allow you to see more of the form on the screen.

(Just click on the Start menu, go to Settings, and select Control Panel.  Find Display and double click on it.  Go to the Settings tab.  Under Desktop Area, drag the slider to change the screen resolution.)  

Figure 1: Switchboard Form
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Figure 2: Database Window
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*From the switchboard menu you can open the database window by pressing the [Unhide Database Window] button or the [Close This Form and Unhide Database Window) button.

On the left of the database window is a list of the objects that can be created in a Microsoft Access database.  The main objects are tables, queries, forms, and reports.

When should each form be completed?  What information is collected on each of the 

7 forms?

Initial Assessment - This form is completed before the patient has attended the education 

program (during a face-to-face meeting with the patient and the diabetes educator).

Demographics, support systems, barriers to learning, provider information, medical history, health behaviors, cultural influences, health beliefs/attitudes, and program information are collected.

Education Record - The first column of this form is completed before the patient has attended the 

education program (during the initial assessment).  The remaining columns are completed after the education program.

A patient’s knowledge/skill level on the following topics is assessed: diabetes in general, acute/chronic complications, exercise, foot/skin/dental care, medications, resources, stress/support, self-monitoring, and nutrition.  As the diabetes educator discusses each item with the patient, (s)he enters the patient’s knowledge/skill level in the first column of the form (“1”=Needs instruction; “2”=Needs review/assistance; “3”=Verbalizes/demonstrates competency).  The patient’s education plan will be based on these assessments.

Note: After the education program, information is entered on the form to 

document the content areas taught (column 2).  Future reinforcements of the 

content areas (column 3) and reassessment of the patient’s knowledge/skill level 

(column 4) can be documented in this form as well.

Education Plan - This form is also completed before the patient has attended the education 

program (during the initial assessment but after the educator has assessed the patient’s knowledge/skill level).

At least one behavioral objective is selected by the patient.  In addition, at least 

one learning objective is selected by the patient and educator.

End of Program - This form is completed by the diabetes educator after the patient has attended 

the education program.

Information on the dates and hours of the education program, as well as 

information on when follow-up on this patient should occur, is assembled.

Follow-up #1 - This form is completed at some specified time (e.g. 3 months) after the patient 

has finished the program.

Information is gathered and entered into the form on the patient’s current health status and whether or not the patient has been able to meet the learning/ behavioral objective(s).  New/revised objectives can be established and recorded on this form.

Optional Forms:
Follow-up (lab and pharmacy data) - This form can be used to document lab and pharmacy 

data at all follow-ups.



Information on lab results, diabetes medications, self-monitoring behavior, and 

exercise is collected.

Follow-up #2, #3, and #4 - This form can be used to document information at follow-ups 

2, 3, and 4 .

New or revised behavioral/learning objectives are entered in this form.

What data do the reports display?

Letter to PCP - This report generates a letter for the patient’s primary care provider indicating 

that his/her patient has completed the education program.  A list of the patient’s 

behavioral objective(s) is included.

Medical Record Note - This report generates a note for the patient’s medical record.  It illustrates 

the dates of the education program as well as the behavior change(s) the patient selected.

Class Summary - This report generates a list of all the patients who have completed the 

education program.

Lab Summary - This report generates a list of lab results from the initial assessment and lab 

results from the follow-up assessment (if available).  


(Note: Under File on the toolbar, select Page Setup.  Select the Page tab.  Under 

orientation, select Landscape.  This will allow you to view and print this report 

properly.)

Enrolled Patients - This report generates a list of all the patients who have enrolled in the 

education program.  (i.e. A list of all the patients with at least an initial assessment.) 

How do you enter data in the forms?

*To open each form, click on appropriate button on the Switchboard Form

1.  Initial Assessment 

Complete Page 1 (use the scroll bar on the right of the screen to scroll down the page) 

and click Continue

Complete Page 2 and click Continue


Complete Page 3



To enter another patient’s initial assessment data click Add Record or
To close the form and go back to the main form click Finished or
To print the form click Print form for current patient
*The next time you open the Initial Assessment Form, a blank record will appear.  If you are inputting data for a new patient, just begin entering the data.  If you want to look at (or edit) data for a patient whose data was entered previously, you can go to the bottom of the screen (where it indicates Record:) and use the back arrow to find the patient or use the binoculars button to open the Find and Replace Box (Figure 3).  In the Find What field, type some unique information about the record you are trying to locate (e.g., “999999999” for Patient ID) and click Find Next.  

(Note: Whatever field your cursor is currently in on the form is what field will be displayed in the Look In field.  If your cursor is not currently in the Patient ID field on the form, move the cursor to this field on the form and then change the Look In field to this or change Look In to search the entire form.)

Figure 3: Find and Replace Box (opens with Binoculars Button)
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*The Patient ID and SSN must be filled in during the initial assessment.  The Patient 

ID will be used on all future forms.  (If you do not want the SSN to appear, than use 

some other UNIQUE identifier for the patient’s ID.  If you do want the patient’s SSN to 

appear on all forms, then just use the SSN as the Patient ID.)

*When going from page 1 ( page 2 or from page 2 ( page 3, it is a good idea to check 

and make sure you are still on the correct patient’s record.  (You can do this by looking at 

the record number or Patient ID.)

*It is not required that all data in this form be collected; however, if you plan to use the database to collect data required by the ADA (for education recognition) than take caution in excluding information.

2.  Education Record

Enter the patient’s ID.  In column 1, enter whether the patient needs instruction (“1”), needs review/assistance (“2”), or verbalizes/demonstrates competency (“3”) for each area.  During or after the program, enter the date of teaching as well as the initials of the person who provided the teaching in column 2.  (Reinforcement and reassessment may also be necessary and the results from these can be collected in columns 3 and 4.) 



To enter another patient’s information click Add Record or


To close the form and go back to the main form click Finished or



To print the form click Print form for current patient
3.  Education Plan

Enter the patient’s ID and click on the boxes in front of the objectives that the patient has 

selected.  Type in the specific information about the objective(s) in the boxes provided.



To enter another patient’s education plan click Add Record or


To close the form and go back to the main form click Finished or


To print the form click Print form for current patient

*Multiple learning/behavioral objectives can be selected.  The ADA requires at 

least one.

4.  End of Program


Enter the patient’s ID (when you enter the ID, additional information about this 

patient - from the initial assessment form - will appear in the gray boxes), dates of program, hrs attended, and follow-up information.



To enter another patient’s information click Add Record or


To close the form and go back to the main form click Finished or


To print the form click Print form for current patient
5.  Follow-up #1


Enter the patient’s ID (when you enter the ID, additional information about this 

patient - from the initial assessment and educational plan - will appear in the gray boxes), 

date of follow-up, health status, pt’s ability to meet objective(s), and new/revised 

objective(s).



To enter another patient’s information click Add Record or


To close the form and go back to the main form click Finished or


To print the form click Print form for current patient
6.  Follow-up (lab and pharmacy data)


Enter the patient’s ID, date of follow-up, weight, lab results, diabetes medications, 

self-monitoring behavior, and/or exercise behavior. 



To enter another patient’s information click Add Record or

To close the form and go back to the main form click Finished or

To print the form click Print form for current patient
7.  Follow-up #2, #3, and #4


Enter the patient’s ID and new/revised objective(s).



To enter another patient’s information click Add Record or

To close the form and go back to the main form click Finished or

To print the form click Print form for current patient
What is a table used for?  Why are there tables in the database?

All data entered into a form is actually saved in a related table.  A form is really just a user-friendly interface used to display, edit, and enter the data.  A table is where the data is actually stored.  (A table is constructed first.  Then the form is developed based on the fields in the table.)  

Below is a list of the 7 main forms in the database, along with their related table. (You can open a table by going to the Database Window (see Figure 2), clicking on Tables, selecting the specific table you are interested in by clicking on it once, and then clicking Open at the top left hand corner of the screen.  To close the table, click on X at the top right hand corner of the screen.  --Feel free to click on Design, instead of Open, to see the description and properties of all the fields in the table.)


Table


Form


Purpose


tbl_initial

initial


Initial Assessment


tbl_edrecord

edrecord

Education Record

tbl_edplan

edplan


Education Plan

tbl_edcomplete
edcompleted

End of Program

tbl_followup

follow-up

Follow-up #1

tbl_followup2

follow-up2

Follow-ups (lab and pharmacy data)

tbl_followup3

follow-up3

Follow-up #2, #3, and #4 (new/revised 

behavior and learning objectives)
Tables can be linked together in a Query.

What is a query?  Why are there queries in the database?

A query is a question you ask that is answered with information from one or more tables in the database.  Two queries currently exist in the database (Query1 and Query2).  Each of these queries combines data from more than one table into a single table.  The new table is then used as the data source for a report in the database.  (You can look at the design of each of these queries by going to the Database Window, clicking on Queries, selecting the query you would like to look at by clicking on it once, and then clicking on Design at the top left hand corner of the screen.  To close the query, click on X at the top right hand corner of the screen.  Note: If you click on the query twice, you will be asked whether you would like to run the query.  Click no and go back and click on the query only once.)    
Query1 (Figure 4) creates a new table (called tbl_initial_edplan_edcompleted) that combines all data from the initial assessment, education plan, and education completed forms.  This new table only includes records for patients that have all 3 forms completed.  Look at the design of the query by using the instructions above.  (Note: If you click on the lines connecting the tables, you can see the join properties.  The tables are related by the patient ID field.)  

Figure 4: Query1
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Query2 creates a new table (called tbl_labsummary) that combines data from the initial assessment and follow-up2 forms.  This new table includes records for patients that have only initial assessment data and records for patients that have both initial assessment and follow-up data.

There are many different types of queries.  You may want to practice creating some queries of 

your own!  (Try these on a COPY of the database!  Not the original!  See instructions below on how to create a copy of the database.)  

How do you make a copy of the database?

1.  Close the database

2.  On the Access File menu, click Open
3.  Find the folder that contains your database

4.  Right-click on the database file

5.  Click Copy on the shortcut menu

6.  Click Ctrl-V on the keyboard to paste the file

7.  A copy of the database now exists

How do you print the forms and reports?

Print Completed Forms -

To print the form for the current record/patient, click on the Print form for current patient button at the end of each form.  (To print forms for all the records/patients, go to the File menu and click Print.)

Print Blank Forms –

If you are planning to collect the data in written format and then enter the data into the database at a future time, you may want to print a blank form.  This may be done by clicking Print Form on the main switchboard form.  A screen will appear with all the forms listed.  Click on the button corresponding to the form you would like to print.  (Note:  The SSN and Patient ID for the blank form will contain 000000000.  MS Access will not print an entirely blank form – at least one field must contain data.  Therefore, a record was created with a SSN/ Patient ID of 000000000.  This record will appear in all tables, forms, and reports.)  

Print Reports (including letter and note) –

Open the report.  On the File menu click Print.
How do you set a password for the database?

The database can be protected by adding a database password:

1.  Close the database.  (Make a backup copy of the database, and store it in a secure place.)

2.  On the Access File menu, click Open.

3.  Select the database you want to open by clicking on it once.

4.  Click the down arrow to the right of the Open button (bottom right hand corner of the box) 

and select Open Exclusive.
5.  On the Tools menu, point to Security, and then click Set Database Password.

6.  In the Password box, type your password.  (Passwords are case sensitive.)

7.  In the Verify box, confirm your password by typing the password again, and then click OK.

The password is now set.  The next time you or any other user opens the database, a dialog box 

will be displayed that requests a password.

Additional Notes:

Margins for forms should be set to ½ inch.

Margins for reports should be set to 1 inch.  

Additional Resources: 

ADA website - www.diabetes.org/recognition
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